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Notice

The information in this document is subject to change without prior notice in order to improve 
reliability, design, or function and does not represent a commitment on the part of this company.

In no event will we be liable for direct, indirect, special, incidental, or consequential damages 
arising out of the use or the inability to use the product or documentation, even if advised of the 
possibility of such damages.

Copyright © 1997 - 2013 SoftLab-NSK Ltd.
All Rights Reserved.

No part of this reference manual may be reproduced or transmitted in any form or by any means 
without the prior written permission of this company.

Throughout this manual, we make reference to product names that are trademarks of other 
companies. We are using these names for identification purposes only, with no intention of 
infringement of the trademarks.

FCC Information

FCC ID: 

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules.  These limits are designed to provide reasonable protection 
against harmful interference in a residential installation.  This equipment generates uses and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications.  However, there is no guarantee that 
interference will not occur in a particular installation.  If this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the equipment 
off and on, the user is encouraged to try to correct the interference by one or more of the following 
measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.
Consult the dealer or an experienced radio/TV technician for help.

Shielded cables and I/O cards must be used for this equipment to comply with the relevant FCC 
regulations. Changes or modifications not expressly approved in writing by SoftLab-NSK Ltd. may 
void the user’s authority to operate this equipment.

Limited Warranty

Our company warrants this product against defects in materials and workmanship for a period of 
one year from the date of purchase.  During the warranty period, products determined by us to be 
defective in form or function will be repaired or replaced at our option, at no charge.  This warranty 
does not apply if the product has been damaged by accident, abuse, misuse, or as a result of service 
or modification other than by us.

This warranty is in lieu of any other warranty expressed or implied.  In no event shall we be held 
liable for incidental or consequential damages, such as lost revenue or lost business opportunities 
arising from the purchase of this product.

 



Table of Contents

Introduction .........................................................................................................................6

General Information ..............................................................................................7

General Information on Program .............................................................................7
1. Purpose, Scope of Application ........................................................................7
2. Sources of Data .......................................................................................................8
3. Scheme of Program Use .....................................................................................8

3.1. Output of Data From One Source ......................................................8
3.2. Successive Output of Data Received From 
Different Sources .................................................................................................9
3.3. Simultaneous Output of Data Received From 
Different Sources .................................................................................................9
3.4. Use of Title Object With TSF_IU Script (ImageUpdater)  ........9

Used Terms and Symbols  .......................................................................................... 11
1. Procedure of Image Updating ...................................................................... 11
2. Project ....................................................................................................................... 11
3. Resulting Graphic File ....................................................................................... 12
4. Task ............................................................................................................................. 12
5. Types of Tasks ........................................................................................................ 13
6. Duration of Task Execution ............................................................................ 13
7. Region File (Template)...................................................................................... 14
8. Requirements to Regions Used in FDImageUpdater ....................... 14
9. Used Signs .............................................................................................................. 15

Image in Resulting Graphic File .............................................................................. 16
1. Content of Image ................................................................................................ 16
2. Text With Data ....................................................................................................... 16

2.1. Structure ...................................................................................................... 16
2.2. Design ........................................................................................................... 17
2.3. Format of Data Displaying .................................................................. 17

3. Size of Image ......................................................................................................... 18
4. Updating of Resulting Image ....................................................................... 19

Program Interface ...................................................................................................22

Launching and Finishing of Program Work ...................................................... 22
1. Ways of Program Launch................................................................................. 22
2. Format of Command Line............................................................................... 22
3. Finishing of Program Work ............................................................................. 23

Program Interface .......................................................................................................... 24
1. Main Window ........................................................................................................ 24



2. Commands of the Main Menu ..................................................................... 25
3. Table for Displaying of Tasks List ................................................................. 25
4. Buttons for Working with Tasks List ........................................................... 26
5. Buttons to Control Project Execution ....................................................... 26

Preview Window ............................................................................................................. 27

Task Settings Wizard ..................................................................................................... 28
Modes of User Interface ....................................................................................... 29

Modes of Program ......................................................................................................... 30

Working with Program ..........................................................................................31

General Workflow of Working With the Program .......................................... 31

Customizing of Program Settings ......................................................................... 32

Creation of a New Project .......................................................................................... 33

Opening of Recently Created Project .................................................................. 36

Editing of Project Settings ......................................................................................... 37
1. Editing of Target Graphic File Settings .................................................... 37
2. Editing of Task Settings .................................................................................... 37

Control Over Image Updating ................................................................................. 39

Creation of Tasks of Different Types ..................................................................... 41
1. Pause .......................................................................................................................... 41

1.1. Purpose ......................................................................................................... 41
1.2. Features ........................................................................................................ 41
1.3. Creation of Task ........................................................................................ 41

2. Text ............................................................................................................................. 43
2.1. Purpose ......................................................................................................... 43
2.2. Data Source ................................................................................................ 43
2.3. Features ........................................................................................................ 43
2.4. Creation of Task ........................................................................................ 44

3. Time ............................................................................................................................ 48
3.1. Purpose ......................................................................................................... 48
3.2. Source of Data ........................................................................................... 48
3.3. Features ........................................................................................................ 48
3.4. Creation of Task ........................................................................................ 48

4. Web ............................................................................................................................. 53
4.1. Purpose ......................................................................................................... 53
4.2. Source of Data ........................................................................................... 53
4.3. Creation of Task ........................................................................................ 53

5. SensorEx  ................................................................................................................. 57
5.1. Purpose ......................................................................................................... 57
5.2. Source of Data ........................................................................................... 57
5.3. Features ........................................................................................................ 57
5.4. Text File for Substitution ...................................................................... 58



5

5.5. Creation of Task ........................................................................................ 59

Sensors and Weather Stations............................................................................69

General Information ..................................................................................................... 69
1. Definition................................................................................................................. 69
2. General Scheme of Working with Sensors and Weather 

Stations ..................................................................................................................... 69
3. The WeatherStationPluginConfig Program Configurator .............. 70

Working With Sensors and Weather Stations .................................................. 71
1. Heavy Weather Station ..................................................................................... 71
2. DIP Modular System Sensors (MA T, MA TPH Models) ..................... 75
3. Stream Labs USB_MS_RS485 Sensor ........................................................ 79
4. Oregon Scientific Weather Station ............................................................. 82

4.1. Working With Oregon Scientific Weather 
StationUsing Virtual Weather Station Software ............................... 82
4.2. Working With the Oregon Scientific Weather 
Stationusing Weather OS  ............................................................................ 87

5. IRT 5920 Sensor .................................................................................................... 91
6. Tundra Sensor ....................................................................................................... 97
7. RMM–4095. Device for Collecting and Processing of 

Data Received from Weather Station ........................................................ 98
8. RMM–4095E. Device for Collecting and Processing of 

Data Received from Weather Station ........................................................ 99
9. Temperature Sensors that Work with the Temp. Keeper 

Program ..................................................................................................................103

Recording of Data on Weather Into a Text Fie ...............................................106
1. General Information ........................................................................................106
2. Recording of Data on Temperature .........................................................106
3. Recording of Data on Temperature, Pressure, Humidity ..............107



6

Introduction

The FDImageUpdater program is designed to form a content of 
graphic file automatically basing on data received from different 
sources.

The program deals with the following data sources: 
specially prepared text files; ●
temperature sensors and weather stations;  ●
website pages; ●
PC system time. ●

Data from source is transmitted into graphic file in a text form. 
Design of image and text is specified by user. 

The program can appeal to different data sources in specified 
time periods and output these data into one file. 

Use of the FDImageUpdater program with other programs from 
the Forward T Software set provides: 

organazing of output on air information that is  ●
changed timely, for example, air temperature;
organizing of output on air information from different  ●
sources in turn and locate it in one place on the screen, 
for example, current time and air temperature.
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General Information

General Information on Program

1. Purpose, Scope of Application
The FDImageUrdater program is used with other programs 
from the Forward T Software set to output on air dynamcally 
changed information received from data sources. 

For example, using the program you may organize output of 
information on time and temperature in titles (1).

The main purpose of the program is to generate and output 
periodically image into graphic file. The image includes a text 
with information received from some data source. 

 
 
 
 
 
 
 
 
 
 

FDImageUpdater

 
Data  

source 

 
Updated 
graphic 

file
(.tga, .png, .bmp,  

.dib, .jpg)

Reads data periodically, 
generates image with 
text with received data, 
records created image 

into updated graphic fileData Generated  
image

1
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2. Sources of Data
The FDImageUpdater program deals with the following sources 
of data:

text file; ●
website; ●
source of time: ●

PC system time; ●
SLTimeServer;  ●

temperature sensors: ●
IRT 5920; ●
Tundra 73; ●
Stream Labs USB_MS_RS485 ●
RMM–4095; ●

weather stations: ●
HeavyWeather (models: WS2308, WS2310,  ●
WS2315; WS3610);
Oregon Scientific (models: WMR100, WMR200); ●
Davis Instruments (Vantage Pro2). ●

3. Scheme of Program Use

3.1. Output of Data From One Source
Picture below presents a general scheme of output on air 
information received by FDImageUpdater program from one 
source of data. 

FDOnAir

Title project

FDImageUpdater
Title element of 
the Picture type

Graphic file  
(task for  

title element of 
the Picture type)

Monitors and 
reloads task file 

periodically Outputs 
on air

Updates image  
periodically

Source of data

Reads information 
periodically
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Complete the following to organize working of the above 
described scheme: 

1. Customize creation and output of image with information 
received from necessary data source into a concrete graphic 
file in the FDImageUpdater program. 

2. Create and save title project in the FDTitleDesigner 
program. The project must contain title element of the  
Picture type. Specify graphic file as a task for the title 
element. The FDImageUpdater program must be 
customized so that to update indicated graphic file. 

3. Load created title project into FDOnAir.

4. Start a process of image updating in the FDImageUpdater 
program. 

6. Start data playback in the FDOnAir program. The 
FDImageUpdater must work in mode of image updating 
during output of title project on air. 

3.2. Successive Output of Data Received From Different Sources
One FDImageUpdater program instance can output data only 
from one source at once. Though, one project created for image 
updating may include tasks for a successive appeal of the 
program to different data sources. 

For example, it is possible to get and output data received from 
PC system time during 30 seconds, then during the next 30 
seconds to get and output data from weather station. In this 
case using one title element time and data on weather are 
successively displayed in the same place on the screen. 

3.3. Simultaneous Output of Data Received From Different Sources
If you need to output data received from different sources 
simultaneously then you must work with a corresponding 
quantity of FDImageUpdater program instances. 

For example, if it is needed to output data on both time and 
temperature simultaneously then 2 title elements of the Picture 
type must be present to output the data. Image for each of the 
elements must be generated by a separate FDImageUpdater 
program instance.

3.4. Use of Title Object With TSF_IU Script (ImageUpdater) 
In cases when it is necessary to output data received from 
different sources simultaneously we recommend working with 
title objects with the TSF_IU script. 

Title object with script is a title object where script assigned to 
this object controls its elements.
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Note: Description of libraries of title objects with script see in the «Scripted 
title objects with open source code» and the «Scripted title objects 
without source code» user's guides.

Work of script applied to TSF_IU script object is similar to work 
of the FDImageUpdater program.

Use of TSF_IU script object at output of data on air does not 
require launching of the FDImageUpdater program.

One title project may contain several title objects with the  
TSF_IU script.

More information on use of title object with the TSF_IU script 
you can find in the «Scripted title object with open source code» 
user's guide.
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Used Terms and Symbols 

1. Procedure of Image Updating
Procedure of image updating denotes a periodic 
implementation of the following steps (see picture below) by the 
FDImageUpdater program:

1. Reading of information from data source.

2. Generating of image that contains a text with received data.

3. Output of generated image into a graphic file. 

When all described above items are implemented data sources 
can be changed at specified time periods.

 
 
 
 
 
 
 
 
 
 

FDImageUpdater

 
Data 

source 2

 
Data 

source N

 
Data 

source 1  
Update graphic  

file
(.tga, .png, .bmp,  

.dib, .jpg)

 
Periodically  
reads data,  

generates image with 
text with received data, 

records generated 
image into updated 

graphic file

Data Generated 
image

..

2. Project
Project is a set of settings for working of program that are 
necessary for updating of image into a concrete graphic file. 

The project includes:
settings of a target graphic file (name and image size); ●
tasks. Each task has settings of parameters for  ●
working with one data source. Quantity of tasks is not 
limited. 

You can create and edit the project in the FDImageUpdater 
program. The project is saved into a text file with s4i extension. 

Only one project can be opened and used in one launched 
FDImageUpdater program instance simultaneously. 
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3. Resulting Graphic File
Resulting graphic file is a file into which one the 
FDImageUpdater program periodically outputs generated 
image after its updating.

Files of the following formats can be used as a result graphic file: 
TGA; PNG; BMP; DIB; JPG.

4. Task
Task is a set of program settings used for generating of image 
with information received from a concrete source.

You must create several tasks to organaze a successive output 
of information into a graphic file from different sources. 

When image is being updated the program successively, in a 
cycle executes project tasks. 

 
Resulting  
graphic  

file

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

FDImageUpdater

Project of image  
updating

Data  
source N

Data  
source 2 

Data   
source 1 Task 1

Task 2

Task N

Resulting  
image 1

Target  
image

Resulting 
image 2

Resulting  
image N

Data

Data

Data

 
.
.
.

 
.
.
.
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5. Types of Tasks
There are different types of tasks to deal with different types of 
data sources. 

The table below presents all existing types of tasks and 
corresponding data sources. 

Type of task Data source

Pause –
Text Text file (*.txt)
Time Source of time
Web Website page
SensorEx Temperature sensor,  

weather station

6. Duration of Task Execution
Duration is one of the parameters that must be specified during 
configuration of project task (for all types of task).

Duration is a time period when program functions with specified 
data source in the task. During this period of time the program 
outputs into updated graphic file images generated according to 
the settings of the task that is being executed. 

 Example: � For organazing of a successive output of the following 
information in titles:

current time, during 10 sec;  ●
outside temperature (data is received from  ●
temperature sensor compatible with program), during 
15 sec;
«output nothing» during 30 sec  ●

it is necessary to create a project in the FDImageUpdater 
program including 3 tasks: 

Task 1 for generating of image with time information.  ●
Type of task is Time; Duration is 10 sec;
Task 2 for generating of image with information  ●
on outside temperature. Type of task is SensorEx; 
Duration is 15 sec;
Task 3 to «output nothing». Type of task is  ● Pause; 
Duration is 30 sec.
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7. Region File (Template)
Region file is a graphic file with rgn extension. 

The file is created by user in the Forward Titling program included 
in the Forward T Software set. Description on dealing with For-
ward Titling program you can find in «FDTitle program (Forward 
Titling). Creation of Titles» user's guide.

Region is an image that is in region file. 

Region is a full-color and multilayer image with alpha channel.

In FDImageUpdater program regions are used as templates for 
generating images.

8. Requirements to Regions Used in FDImageUpdater
Region that is used as a template in FDImageUpdater must 
necessarily include at least one text object (Text box). At 
updating of image text with output data is placed into this text 
object. 

 Example: � Picture below presents Forward Titling program window. The 
Region_Example.rgn region (1) is located in working space of the 
window. The region is designed with a transparent filling (2) 
with a text object (3) over it. 

The Object Tree window (4) displays name of text object specified 
by user – For placing (5).

5

4

1

2

3
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Name of a text object is used in FDImageUpdater program to 
indicate an object where output data must be placed. 

Text in region of text object during generating of an image is 
fully replaced by text with output data. 

 Example: � Picture below presents an image with title overlay that displays 
information on weather. 

For generating of this image in FDImageUpdater a region with 
a transparent filling is used. There is one text object located 
over transparent filling. 
Picture below shows ForwardTitling program window with 
opened region used in this example. 

 
Text «00» located in text object of region at generating of 
image in FDImageUpdater program is replaced by text with 
information on temperature. 

9. Used Signs
Click denotes clicking left mouse button.

Right-click denotes clicking right mouse button.
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Image in Resulting Graphic File

1. Content of Image
Image in resulting graphic file is an image that is generated by 
FDImageUpdater program and is output into updated graphic 
file at execution of a procedure of image updating. 

Design of resulting image is specified by content of a region file 
that is used as a template of generated image. 

Besides image that is in region file resulting image also has text 
with information received from data source.

 Example: �

Text with 
information from 

data source  

Image that is in region file  
(template)

Result image  

2. Text With Data

2.1. Structure
Generally text with data that is output in resulting image has 
the following structure:

<Prefix><Text with information received from data source><Postfix>, 

where
Prefix  ● is a text that is automatically added before text 
with data at generating of a resulting image;
Postfix  ● is a text that is automatically added after text 
with data at generating of a resulting image.

Prefix and postfix are specified by user at customizing of image 
updating procedure. Their presence is not obligatory. 
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 Example: � At output of information on temperature units of measure are 
also displayed (°C). Temperature sensor sends only temperature 
value. To output units of measure you must add « °C» postfix to 
output data.

 
Region file  
(template)

 
 
 
 
 

FDImageUpdater

–12,0

Information  
from temperature 

sensor
–12 °C

Generating of 
field with  

data  
(adding of  

« °C» postfix)

Image from resulting 
graphic file 

Placing of data 
region  

text object

 

2.2. Design
In resulting image text with output data is rendered according 
to style specified in text object of a region used for data placing  
(font, effects list, etc.).

2.3. Format of Data Displaying
The program provides with a possibility of customizing a format 
of displaying of data received from the following sources: 

temperature sensors and weather stations – it is  ●
possible to select format of displaying of numerical 
values. 
For example, +26,7 temperature can be output in 
resulting image in one of the following ways:

«26»; ●
«26,7»; ●
«+26»; ●
«+26,7». ●

time source:  ●
12- or 24-hour format (for example,   ●
«05:10» or «17:10»;
at output of time in 12-hour format: ●

add «AM/PM» after time value (for example,  ●
«05:10 РМ» or «05:10»); 
output time value that is less than 10 with a  ●
leading zero or without it (for example, «5:10» or 
«05:10»);

select separator that is put between hours and  ●
minutes values («:», «-», «;», «/», «,»).
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3. Size of Image
Width and height of resulting image are specified by user at 
customizing of a project.

Minimal size of output image is 10 × 10, maximal size is 
2048 × 2048 pixels.

It is also possible to work with regions which sizes do not 
correspond to size of a resulting image specified in project 
settings:

if region size is smaller then resulting image is  ●
an image created basing on a region with added 
transparent fields along the edges proportionally (see 
Example below);
if region size is larger then result image is an image  ●
created basing on a region with proprotionally cut 
edges (see Example below).

 Example: � Let us consider resulting images of different sizes created via 
FDImageUpdater program basing on one the same region 
(template). 
Picture below presents image of used region. Size of the region is 256 х 
138 pixels.

Table below presents resulting images of different size created 
basing on created region.
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№ Region  
size

Size of resulting image 
specified by user, in pixels

Resulting image

1 256 х 138 256 х 138  
(size of target image 
corresponds to template size)

2 256 х 138 288 х 200 
(size of resulting image is 
larger than template size)
Transparent background is 
marked by grey-and-white 
squares on the picture.

3 256 х 138 192 х 100 
(size of resulting image is 
smaller than template size)

4. Updating of Resulting Image
During a procedure of updating image in a resulting graphic file 
is updated periodically.

Starting to execute the next task of project the 
FDImageUpdater program generates image according to the 
settings of this task and records the image into a resulting file. 

During time when task is being executed the program reads 
periodically data received from specified source in task and 
outputs into file again generated image with the last read data. 
Periodicity when program appeals to sources of different types 
is different. 

Image with the last data read from specified source is stored 
in resulting graphic file either till the next data reading or till 
start of execution of the next task of the project (depending on 
what happens firstly).
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 Example:  � Let us consider an example of a project with 3 tasks to 
demonstrate a process of image updating. During execution of 
tasks images with the following information are output into 
update project file: temperature (Task 1); air pressure  
(Task 2); humidity (Task 3). 

Let us consider the first cycle of tasks executing. 

Table below presents a brief description of tasks. For moments 
of time that correspond to moments when data is updated 
received information and image generated basing on this 
information are shown. 

Breif description of 
task

Time Information 
from data 
source

Image in updated file  
(grey-and-black squares 
denote transparent 
background of image)

from start 
of task 
execution

from start of 
execution 
of update 
procedure

Name: Task 1
Duration: 15 sec
Update every: 5 sec
Postfix: °C 

0 0 –2

5 sec 5 –2

10 sec 10 –1

Name: Task 2
Duration: 15 sec
Update every: 5 sec
Postfix: mm HG 

0 15 757

5 sec 20 757

10 sec 25 758

Name: Task 3
Duration: 15 sec
Update every: 5 sec
Postfix: %

0 30 96

5 sec 35 97

10 sec 40 98

Picture presents screenshots made in different time. 
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155 10 20 25 35 400 30 45

Time of execution, sec

Execution of Task 1  Execution of Task 2 Execution of Task 3
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Program Interface

Launching and Finishing of Program Work

1. Ways of Program Launch
The program can be launched at opening of the  
~\ImageUpdater\FDImageUpdater.exe file, where ~ denotes a full path 
to the folder where ForwardТ Software set is installed.

To launch the program you can use:
program shortcut located on desktop; ●
the  ● Start menu command:  
Programs > ForwardT Software > Titles > Image Updater;
command line. ●

When the program is launched its main window opens and the 
icon     appears in taskbar notification area.

2. Format of Command Line
You can also launch the program from command line that has 
the following format:

"ProgramFile" ["ProjectFile"][/run[:time]][/h]

where:
ProgramFile  ● is a full path to the FDImageUpdater.exe 
file;
ProjectFile ●  is a full path to file of project. This 
parameter is not obligatory. If path to file is not 
specified then the last opened during the previous 
program session project is loaded into the program;
/run ●  is a key for automatic switching of the program 
into mode of execution after launching. This 
parameter is not obligatory. If the key is absent the 
program is launched in configuration mode; 
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:time ●  is time of execution of a project. This parameter 
is not obligatory. The parameter is used only if /run 
key is specified. If :time parameter is not specified then 
the program works in mode of task execution till stop 
command from user is not received. If :time parameter 
is specified the program works during time minutes, 
then execution of project is stopped and the program is 
closed;
/h ●  is a key for minimizing of program window into tray 
after launching. This parameter is not obligatory.

 Important: 8 If names of files and folders have spaces then path to file in command 
line must be enclosed in double quotes – (« ...»).

 Example: � "C:\Program Files\ForwardT Software\ImageUpdater\ 
FDImageUpdater.exe" "D:\Users\222.s4i"/run:25 
Result of command executing: launch of the FDImageUpdater 
program, loading of the D:\Users\222.s4i project into the 
program, execution of project during 25 minutes, 
exiting the program.

3. Finishing of Program Work
You can finish working with the program via:

the  ● Exit button located in the main program window;
the  ● Exit button of the context menu of program icon.

 Important: 8 It is impossible to close the program via the  button located in 
title bar of the main program window. 
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Program Interface

1. Main Window
At launching of the program its main window appears. Title bar 
of the main window displays name of the program and name of 
file of current project.

6 8

1

2

5

7

3

4

The main program window has the following elements:
main menu (1) with commands to control projects files,  ●
opening of settings windows, etc.;
line with displayed full name of resulting graphic file of  ●
current project (2);
table for displaying of a list with tasks for current  ●
project (3);
information area for displaying of data on settings of  ●
selected task (4);
buttons for editing of a tasks list (5); ●
check box to control preview window (6); ●
buttons to control execution of procedure of image  ●
updating (7);
the  ● Exit button (8) to exit the program. 
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2. Commands of the Main Menu
The main program window menu consists of 2 submenus: 

File  ● submenu with commands to control projects files;
Settings ●  submenu with commands to customize 
parameters.

Name Purpose

File submenu
  New project ... create a new project
  Open project ... open earlier created project from file
  Save project save project into file
  Save project as... save project into file with another name

Settings submenu
  Project settings... open the Project settings window
  Program settings... open the Program settings window

3. Table for Displaying of Tasks List
1 2 3 4 5

The following information on project tasks is displayed in table 
column headers: 

(1) is a mark that displays current state of task  ●
(is displayed only in a ready mode and in mode of 
execution);
Type  ● (2) is a pictogram that indicates type of a task;
Name ●  (3) is a name of file; 
Duration  ● (4) is a duration of task execution;
Region file  ● (5) is a name of region file used in task. 
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4. Buttons for Working with Tasks List

The following buttons are used for working with tasks list:
Add...  ● button is used to create a new task. The task is 
added to the end of a list; 
Edit... ●  button is used to edit parameters of selected 
task;
Copy ●  button is used to copy task. The copy of a task is 
added into a list after task that is being copied;
Delete ●  button is used to delete selected task;
Move up ●  button is used to move selected task one row 
up;
Move down ●  dutton is used to move selected task one 
row down.

5. Buttons to Control Project Execution

Control over a procedure of image updating is implemented via 
buttons located in the main program window:

Prepare ●  button is used to start automatic preparation of 
the program to execute tasks of project – to switch into 
mode of preparation; 
Start ●  button is used to start a procedure of image 
updating; 
Stop ●  button is used to stop preparation or a procedure 
of image updating.
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Preview Window

Preview window is an additional window of the 
FDImageUpdater program used for displaying of image that is 
output into a graphic file. The image is displayed in the window 
only when a procedure of image updating is being implemented. 

Preview window is opened at putting of the Show preview window 
check mark in the main program window. Name of a graphic 
resulting file is displayed in title bar (1) of the main program 
window. 

1

Size of a preview window adjusts automatically to size of a 
resulting image. 
Select Always on Top in drop-down window menu for the window 
to be always placed over other windows. 

The menu is opened by right-clicking title bar of a preview 
window. 
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Task Settings Wizard

Creation and editing of project tasks are implemented via Task 
settings wizard. 

Picture below presents Task settings wizard window, step 1 of 2.

2

1

3

4

5

The Task settings wizard window has the following elements:
information fields: ●

(1) is a field with information on actions  ●
implemented on the current step of Wizard, type 
and name of current task;
(2) is a list of steps to configure task parameters; ●
(4) is a field with information on customizing of  ●
parameters on the current step;

elements to configure task parameters on the current  ●
step of Wizard (3);
buttons to control work of  ● Task settings wizard (5):

Back ●  is for switching to the previous step of Wizard;
Next ●  is for switching to the next step of Wizard;
Finish  ● is for ith saved made configuration;
Cancel ●  is for exiting Wizard without saving of made 
configuration.

Set of configured parameters and quantity of wizard steps are 
different for different types of tasks. 
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Modes of User Interface
The program has 2 modes of interaction with user:

window mode (when the main program window is  ●
maximized);
minimized mode (when the main program window  ●
is minimized and there is a program icon in taskbar 
notification area). 

 
 
In a minimized mode control over program work is 
implemented via commands of a context menu that is 
opened by right-clicking the icon in taskbar.  
 

Click the  or  icon to minimize the main program window. 

Click the      icon to restore the main program window. The icon 
is located in taskbar notification area. 
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Modes of Program

The program has 4 modes of working:
customizing; ●
preparing for execution; ●
readiness; ●
execution. ●

The scheme below presents a brief description of the 
FDImageUpdater program modes of working with their all 
possible switchings.

 
FDImageUpdater mode of working

Customizing 

customizing of general  
parameters of a project;
creating and changing  

of project tasks

Execution 

execution of image 
updating procedure

Preparing for 
execution

 the program monitors data 
sources used at implementing 
of image updating procedure

Readiness 

the program is ready to 
start procedure of image 

updating

Switching between modes can be implemented both on user 
command and automatically. Detailed description of modes 
switchings you can find in the Launch of Image Updating 
Procedure Section.
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Working with Program

General Workflow of Working With the Program

1. Launch the FDImageUpdater program.

2. Customize parameters of program for further dealing with 
it. 

3. Create new or load created earlier project of image updating 
in the progam. 

4. Launch procedure of image updating (project).
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Customizing of Program Settings

Program settings are customized in the Program Settings window 
that is opened via the Settings > Program Settings… menu 
command.

2

3

1

4

The Program Settings window has the following elements:
Language selection ●  (1) where you can select language of 
program interface;
Show Save project file prompt message  ● check box (2) – if 
the mark is put then at opening of another project or 
at exiting the program the prompt on if is it necessary 
to save current project or not appears; if the mark is 
not put then no prompt appears and the last made 
changes of the project are not saved; 
Clear target image file when updating is stopped ●  (3) – if the 
mark is put then at stopping of updating procedure 
the program clears target file by recording an empty 
and transparent image into it; if the mark is not put 
then the image is rest in updated file (in this case 
rest image is the latest recorded image at project 
execution);
Time restriction on the task preparation  ● element (4) is a 
maximal time necessary for preparation of one task 
to be executed (during being of the program in the 
preparing mode). If during specified time the task is not 
prepared then at updating of image this task is not 
implemented. 

The OK button is used to save settings and return into the main 
program window. At clicking of Cancel the window is closed 
without saving made comfiguration. 
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Creation of a New Project

1. Select the New project... command in the File menu of the 
main program window. 

2. The Create New Project window appears.

1

2 3

Complete the following in the Create New Project window: 
specify a folder where project file will be stored in the  ●
Save in drop-down list (1);
specify name of file project in the  ● File name field (2);
click the  ● Save button (3). The window is closed.

3. The Program Settings window appears automatically.

4. Click the Browse... button (4) in the Target image file group. 

4
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The Select Target Image File window appears.

5

6

8

7

Complete the following in the appeared window: 
select folder in the  ● Look in drop-down list (5) where 
target image file of customized project is stored;
specify name of a target graphic file: ●

select file in the list of files (6) if updated project  ●
file has already been created;
if the file is not created yet then specify its name  ●
and extension in the File name text field (7). The file 
will be created when the image is updated. If name 
extension is not specified then the file will have the 
tga extension automatically;

click  ● Open (8). The window closes.
A full path to the specified file is displayed in the Project  
Settings window in the Target image file field (9).

5. Specify width (10) and height (11) values in the Output image 
size (pixels) group of elements. 

9

10 11

12
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6. If it is needed put the Write weather data to text file mark (12) 
and customize corresponding parameters. Information 
on customizing you can find in the «Sensors and Weather 
Stations» section, «Recording of Weather Data Into a Text 
File» section.

7. Click OK.

8. Now the main program window has the following 
appearance:

9. Configure task for project. 
A workflow of creating of tasks you can find in the «Creation 
of tasks» section. 

10. Save created project by selecting the Save project command 
in the File menu.
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Opening of Recently Created Project

Complete the following to open a recently created and saved 
project:

1. Select Open project... command in the File menu. 

2. Specify a folder and FDImageUpdater project file that is 
necessary to open in the appeared window. 
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Editing of Project Settings

1. Editing of Target Graphic File Settings
Editing of settings of a target image file and its size is 
implemented in the Project Settings window. 

The window is opened by clicking Setitngs > Project settings... 
menu command. 

2. Editing of Task Settings
Complete the following to edit project task settings: 

1. Click line with task that you want to edit (1) in the table 
with a list of tasks in the main program window. 

21

2. Click Edit... (2), the Task settings wizard window appears.

3
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3. Open the Task settings wizard window where you can edit task 
parameters using the Next button (3). 

4. Edit task parameters and then click Finish (4). 

 

4

 The Task settings wizard window closes. 

6. New task settings are displayed in the main program 
window. 
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Control Over Image Updating

A procedure of image updating is started only when image 
updating project is loaded into the program. 

Complete the following to start procedure of image updating 
(execution of a project):

1. Click Prepare (1) in the main program window. 

1

2. The program switches into a mode of preparation for execution 
of tasks of a project. 
The program implements a test scanning of data sources 
specified in task, checks presence of region files, etc. in this 
mode. 
Task is not prepared to be executed if during time specified 
in the Program Settings window as Time restriction on the task 
preparation the program can not link with data source. 

3. When preparation is complete the program switches to one 
of the following modes automatically:

readiness ● , if at least one of the tasks is prepared 
correctly;
customizing ● , if tasks can not be prepared. 

4. If one or more tasks are prepared correctly the program is 
switched to the readiness mode. 
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2

3

The Start and Stop buttons (2) are available in this mode.
The  mark (3) in the table with tasks list marks tasks of 
the project that are not prepared for execution. 
The program can be switched to one of the following modes 
from mode of readiness:

mode of  ● execution – by clicking Start;
mode of  ● configuring – by clicking Stop.

5. Click Start to launch a procedure of image updating. 
The program switches to a mode of execution. In this mode 
the program updates image automatically. Tasks of a project 
that are prepared will be executed in this case.  
The  mark (4) in the table with tasks list marks the task 
that is being executed at the moment. 

4

6. Click Stop to stop executing of a procedure of image 
updating. 
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Creation of Tasks of Different Types

1. Pause

1.1. Purpose
Use of such tasks allows sustaining a pause among images that 
replace each other. 

1.2. Features
At execution of the Pause task updating file stores an image 
that is a rectangle with a transparent filling. 

1.3. Creation of Task
1. Click Add... in the main program window, the Task settings 

wizard - Step 1 of 2 window appears. 

Specify task type – Pause.
Enter task name in the Name field. 
Specify duration of task execution in the Duration field. 
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2.  Step 2.

Information on made configuration is displayed at this step. 
Click <Back in the Wizard window if it is necessary to change 
some settings specified at the previous step. 
Click Finish if all settings are correct. 

3. After clicking Finish work of Wizard is finished and the task 
will be added to the list with tasks displayed in the main 
program window. 
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2. Text

2.1. Purpose
Task of the Text type is used to output information from a text 
file. 

2.2. Data Source
In tasks of the Text type data sources are specially prepared text 
files with the txt extension. 

Each paragraph in the file must be in the following format: 
object_name: line with symbols

where: 
object_name: ●  is a name of a text object in region file 
where the data is put. After name of the object you 
must necessarily put a colon;
line with symbols ●  is an information to be output. 

2.3. Features
1. You can vary information in a text file either manually or 

by means of a specific set of programs during execution of a 
procedure of image updating. 

2. You can organize placing of data into several region text 
objects simultaneously (see an example). 

 Example: � Picture below displays an image generated by 
FDImageUpdater as a result of execution of the Text 
type task (“grey-and-white” filling is used to denote a 
transparency).

This image was generated via region given below. 
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1
3

2

4

The region (1) has 3 text objects for placing of data. Names of 
objects are:  
Text_box6 (2), Text_box5 (3), Text_box4 (4).

Picture below shows a prepared text file under the Data.txt 
name. The file is used as a source of data. 

2.4. Creation of Task
You must implement the following before configuring of a task 
of the Text type:

create region file that is image template; ●
create TXT file that is data source.  ●

Creation of a task:

1. Click Add... in the main program window, the Task settings 
wizard – Step 1 of 2 window appears.
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The Name text field displays name of a task specified by 
default – Untitled. To specify another name clear the field and 
enter a new one. 
Specify duration of task execution in the Duration field. 
During specified time period image will be updated 
according to settings of the given task.
Select type of task (Text) in the Type drop-down list. Steps for 
configuring will be displayed in the list of steps for this type 
of the task. 

Click Next> to continue.
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2. Step 2

Click Browse... to open a standard dialog window and select 
region file used in the given task as an image template. 
Click Next> to continue. 

3. Step 3

Click Browse... to open a standard dialog window and select 
text file used in the given task as a source of data. 
Click Next> to continue. 
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4. Step 4

Information on made configuration is displayed at this final 
step. 
Click <Back in the Wizard window if it is necessary to change 
some settings specified at the previous step. 
Click Finish if all settings are correct. 

5. After clicking Finish work of Wizard is finished and the task 
will be added to the list with tasks displayed in the main 
program window. 
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3. Time

3.1. Purpose
Tasks of the Time type are used to organize output of current 
time. 

3.2. Source of Data
One of the following sources of time can be used in tasks of the 
Time type:

PC system time; ●
SLTimeServer – system server for keeping and  ●
synchronizing of time. SLTimeServer is included in 
the Forward T Software products set. More detail 
on working with SLTimeServer you can find in the 
«SLTimeServer: Time Server» document.

3.3. Features
You can organize output of current time via tasks of the Time 
type in the hh:mm format.

There is a possibility of customizing format of time displaying:
specify time format (12 or 24 hour format); ●
select a separator that is put between hours and  ●
minutes ( «:», «.», «-», «.», «;»);
enable/disable displaying of:  ●

a leading zero in hours; ●
AM/PM indicator at output of time in 12-hour  ●
format.

3.4. Creation of Task
Create a region file before configuring of a task of the Time type. 

Creation of task:

1. Click Add... in the main program window, the Task settings 
wizard - Step 1 of 2 window appears.
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Specify task type – Time.
Enter task name in the Name field. 
Specify duration of task execution in the Duration field. 

Click Next> to continue.
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2. Step 2

Click Browse... to open a standard dialog window and select 
region file used in the given task as image template. 
Select name of region object where data will be placed in the 
Text box for replacement drop-down list.
Click Next> to continue.

3. Step 3

Specify source of time in the Time source drop-down list. 
Click Next> to continue.
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4. Step 4

Customize format of time displaying by:
putting the  ● Show first zero mark to display zero before 
time values that have one number (for example, 05);
putting the  ● 24 h format mark to output time in  
24-hour format. If the mark is absent then information 
on time is output in 12-hour format;

putting the  ● Show AM/PM mark if time is output in 
12-hour format to display AM/PM indicator (at 
midnight/past midnight);

selecting in the  ● Separator drop-down list a separator 
that is put between values of hours and minutes.

Enter text in the Prefix field that should be before output 
data in output image.
Enter text in the Postfix field that should be after output 
data in output image.
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5. Step 5.

Information on made configuration is displayed at this step. 
Click <Back in the Wizard window if it is necessary to change 
some settings specified at the previous step. 
Click Finish if all settings are correct.

6. After clicking Finish work of Wizard is finished and the task 
will be added to the list with tasks displayed in the main 
program window.
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4. Web

4.1. Purpose
Tasks of the Web type are used to organize output of 
information taken from a web page. 

4.2. Source of Data
Source of data for tasks of the Web type is a website page. 

Configuration necessary for receiving of data from a website 
is implemented in the SLWebTracker program. The settings 
are saved in file with the *.webtrackerproj extension that is 
a SLWebTracker project (information on dealing with the 
program you can find in the «FDWebTrackеr. User's Guide» 
document). 

At configuring of Web tasks you should specify name of file 
of necessary SLWebTracker project in the FDImageUpdater 
program. 

4.3. Creation of Task
You must create the following before configuring of a task of the 
Web type:

region file that is a template of an image; ●
the SLWebTracker project. Information on dealing  ●
with the program you can find in the «FDWebTrackеr. 
User's Guide» document. 

Creation of task:

1. Click Add... in the main program window, the Task settings 
wizard - Step 1 of 2 window appears. 
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Specify task type – Web.
Enter task name in the Name field. 
Specify duration of task execution in the Duration field.

Click Next> to continue.

2. Step 2

Click Browse... to open a standard dialog window and select 
region file used in the given task as image template. 
After selecting of the region file a list of all text objects 
names that are in the region appears in the Text box for  
replacement drop-down list. 
Select the necessary one and then click Next> to continue.
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3. Step 3

Click Browse... to open a standard dialog window and select 
the SLWebTracker project file.
Click Next> to continue. 

4. Step 4

Enter text in the Prefix field that should be before output 
data in output image.
Enter text in the Postfix field that should be after output 
data in output image.
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5. Step 5

Information on made configuration is displayed at this step. 
Click <Back in the Wizard window if it is necessary to change 
some settings specified at the previous step. 
Click Finish to finish creation of task. 

6. The task is added to the list with tasks displayed in the 
main program window.
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5. SensorEx 

5.1. Purpose
Tasks of the SensorEx type are used to output sensors and 
weather stations meters.

5.2. Source of Data
Tasks of the SensorEx type are used to output data received from 
the following sources:

Temperature sensors: ●
IRT 5920; ●
Tundra 73; ●
Stream TPH: ●
RMM-4095 (Profitt Meteo Meter); ●
DIP Modular System; ●

Weather stations: ●
HeavyWeather (models: WS2308, WS2310,  ●
WS2315; WS3610);
Oregon Scientific (models WMR100, WMR200); ●
Davis Instruments (Vantage Pro2). ●

The list of used sensors is expanded. 

5.3. Features
1. The SensorEx line is displayed in the Type drop-down list 

only in that case if at least one sensor is plugged to PC, 
configured and ready to work. 

2. User specifies periodicity of reading data received from 
source. 

3. At output of data into graphic file meterage of sensors can 
be adjusted to a specific value automatically.
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4. Region that is a template may include any number of text 
objects. 
Meterage of both one and several sensors also can be output 
into one text region object. 
Order of distributing of output meterage among text region 
objects is specified at creating of a task. 

5. When dealing with some sensors text files for substitution 
can be used. 

5.4. Text File for Substitution
When dealing with some sensors there is a possibility to 
replace output numerical values by a special text in the 
FDImageUpdater program (see example). 

Substitution text files are used to correspond received sensors 
values to output text. 

Text file for substitution is a specially prepared text file (*.txt) 
that has a set of lines in the following format: 

<Boundary _value 1><space><Text for_substitution 1> 
<Boundary _value 2><space><Text for_substitution 2> 
... 
<Boundary _value N><space><Text for_substitution N> 

where: 
< ● Boundary _value> is a maximal value of a scale range 
that corresponds to output <Text for_substitution>.
< ● Text for_substitution> is a text that is output into 
a target image instead of a numerical value from 
spcified range.

Lines in substitution file must be put in an increasing order of 
Boundary_values, i.e. Boundary _value 1 must be less than  
Boundary _value 2, Boundary _value 2 must be less than Boundary 
_value 3, etc.

Principle of working with a substitution file is the following: 
value received from a sensor is successively compared with 
Boundary_values recorded in a subsitution file beginning from 
the first file line. Text for_substitution from the first searched line 
is finally output into a target image. Boundary _value in this line 
must be greater than received numerical value.
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 Example: � Information on bearing of an apparent wind is received from 
a sensor in degrees (0–360°). In daily life wind direction is 
specified according to a quarter from where it is blowing (North, 
Northeast, etc.).
Picture below presents an example of a text file for substitution 
used to output information on wind direction. 

For example, if the FDImageUpdater program receives from 
sensor 183,5 degrees of a wind direction then the «South» 
value is output into a target image (the value is in 157,5–202,5 
range).

5.5. Creation of Task
Preliminary preparation:

1. Plug a sensor (weather station) to PC and complete 
necessary configuration (see the Working with Sensors and 
Weather Stations section).

2. Create a region file used as an image template.

3. Create a text file for substitution if it is supposed to use a 
text file for substitution at data output. 

Creation of task:

1. Click Add... in the main program window, the Task settings 
wizard - Step 1 of 2 window appears.
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Specify task type – SensorEx.
Enter task name in the Name field. 
Specify duration of task execution in the Duration field.

Click Next> to continue.
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2. Step 2

Click Browse... to open a standard dialog window and select 
region file used in the given task as image template. 
Select name of region object where data will be placed in the 
Text box for replacement drop-down list.
Click Next> to continue working.

3. Step 3
At this step you create a list of sensors which meterage 
must be output. 

1

2

List of sensors is displayed in the table (1). 
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Complete the following to add sensor to the list: 
Click 1. Add sensor (2) in the Task settings wizard, step 3 
window.  
The Add sensor window appears: 
 

 
Select necessary sensor in the Select sensor drop-down 
list.  
 

 
 
The Select sensor list has all sensors available for 
working. A set of included into the list sensors 
depends on the settings made at preliminary steps 
(see the Working with Sensors and Weather Stations 
section).  
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Customize format of presentation of sensor meterage 2. 
in a target file.  
 
 
 
 
 
 
 
 
 
 
 
Depending on selected sensor one of two groups of 
elements becomes available to configure the format of 
sensor values displaying:
Use sensor value ●  (1) is information received from a 
sensor that is output as a numerical value. In this 
case:

select a format of data output in the  ● Format  
drop-down list; 
customize correction of values via the  ● Correction 
group by specifying of a value in the text field. 
Put the Subtract mark to reduce output value till 
corrected value. If the mark is absent then output 
value is increased till corrected value;

Use text replacement for sensor value ●  (2) group of elements 
is used when a text from file for substitution is output 
into target file and the text corresponds to numerical 
value (for example, for wind direction not degrees are 
used but name of direction). In this case click Browse... 
to open a standard dialog window and select text 
file for substitution (detailed information on file for 
subsitution see above);
Click 3. Оk to close the Add sensor window. 

Name of added sensor is displayed in the table with a list of 
sensors. 

1

2



64

Repeat given above steps to select all necessary sensors.

Specify time period (in seconds) between each reading of 
data from a sensor in the Refresh every field.
Click Next> to continue.

4. Step 4
Templates of text lines that are substituted into text objects 
of a region are created at this step of Wizard.
Table with a list of text objects names that are in a region 
file is displyed in the Wizard window (region file is specified 
at Step 2). 
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Complete the following to customize template of a line that 
is output into a concrete text object of region: 

1. Right-click the line with name of a region text object (1) and 
click the Set value... button (2).

2. The following window appears.

4a

4b

3

4

The window has:
the  ● Value text field (3) used for output of a template of 
a value line;
field with some explanations on forming of a line with  ●
value (4) that includes:

a description of line format (4а); ●
a list of sensors (4b). In this list you must specify  ●
index <#N> for each sensor (N = 1, 2, ... n, where n 
is a total number of sensors in the list). 

1
2
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Template of a line has the following format:
Free_ext_1<#N1>Free_text_2<#N2> ... Free_text_n<#Nn>,
where: 

Free_text is an arbitrary text created by user. The text is 
output into target image without modifyings;
<#Ni> is an index of used sensor. Sensor meterage is 
output in a target image instead of a tag with sensor 
index. 

3. Specify line value in the Value text field.

 Click ОК. The window is closed. 

4. Created template of value line is displayed in the Value 
column of the Wizard window. 
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Click Test to test how created according to the template line 
looks like with sensor values. The line is displayed in the 
text field. 

Specify values for all text objects where it is necessary to 
output data.

Click Next> to continue.

5. Step 5.

Information on made configuration is displayed at this step. 
Click <Back in the Wizard window if it is necessary to change 
some settings specified at the previous step. 
Click Finish to complete creation of the task.
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6. The task is created. It is displayed in the list with tasks of 
the main program window.
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Sensors and Weather Stations

General Information

1. Definition
Sensor (of temperature, pressure, humidity, etc.) is a device 
used for measuring of a concrete weather parameter that 
converts the measurement into a useful for being used signal. 
The sensor can be either a separate device or be included into 
weather station set. 

Weather station is a device used for measuring of different 
weather parameters that includes a set of special sensors. 

At the current moment the FDImageUpdater application 
supports the following weather stations and sensors:

temperature sensors: ●
IRT 5920; ●
Tundra 73; ●
Sahara; ●
DIP TTE24 ●

weather stations: ●
HeavyWeather, models: WS2308, WS2310,  ●
WS2315, WS3610;
Oregon Scientific, models: WMR100, WMR200; ●
DAVIS Instruments, Vantage Pro 2 model; ●
DIP MS; ●
StreamLabs TP. ●

The list of supported equipment is expanded.

2. General Scheme of Working with Sensors and Weather Stations
1. Plug device to PC. Install software to output measurings on 

PC if it is included into software set. 

2. Be sure that the device functions correctly. 

3. Customize the device via the WeatherStationPluginConfig 
program configurator.
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4. Launch the FDImageUpdater program. Create task of the 
SensorEx type used to output data from plugged to PC device 
(see the Creation of Tasks section).

3. The WeatherStationPluginConfig Program Configurator
The WeatherStationPluginConfig program is used to configure 
weather stations and temperature sensors used by programs 
from the Forward T software set. 

Installation of the program is implemented automatically when 
the ForwardT Software set is being installed. The program is 
installed in the ~\Tools\WeatherStations folder,  
where ~ is a full path to the folder where ForwardT Software 
set is installed.

General workflow of working with the program:

1. Launch the program.

2. Pass to the tab which name corresponds to the name of 
weather device to be configured in the appeared window. 

3. Customize parameters on the tab and put the Is Active mark.

4. Close the program.
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Working With Sensors and Weather Stations

1. Heavy Weather Station
1. Turn PC off. Plug weather station to PC СОМ port. 

2. Plug weather station into COM port. Turn PC on. 

3. Install necessary software using the disk included in 
weather station set. The software is used to output 
measurings on PC (HeavyWeather PC Software). 
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4. Launch the application used for output of data from Heavy 
Weather station on PC. 

5. Click the Setup button in the appeared window.

 

6. Customize the following in the appeared window:
select COM port to which the station is connected in  ●
the Com Port No drop-down list on the Global tab;
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specify units of output measurings on the  ● Units tab as 
it is shown on the picture below.

Click OK to exit the window with saving of all customized 
settings. 

7. Data received from weather station is displayed in the heavy 
weather main program window in several seconds. 

 

8. Click Exit to exit the program. The program must be closed 
at further working. 

9. Launch the WeatherStationPluginConfig weather station 
configurator (C:\Program Files\ForwardT Software\Tools\
WeatherStations\WeatherStationPluginConfig.exe).

10. Pass to the Heavy Weather tab.
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Customize the following items:
select model of used device in the  ● Model drop-down list;
specify a full path to the file that launches the  ●
program that outputs data received from weather 
station on PC in the Application file field (for example, 
heavy weather.exe). For this use the Browse... button to 
open a standard dialog window and select the file;
specify time interval between reading cycles of data  ●
from weather station in the Refresh every field; 
put the  ● Is active mark.

11. Close the WeatherStationPluginConfig program by clicking 
ОК. The program must be closed at further working. 
Weather station is prepared to be used by FDImageUpdater 
program.

12. Create task of the SensorEx type in the FDImageUpdater 
program (see the Creation of Tasks section). Select sensors 
which names begin with the WSxxxx prefix, where xxxx is an 
index of weather station model. 
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2. DIP Modular System Sensors (MA T, MA TPH Models)
1. Plug sensor to PC local net and network. Turn the device on. 

2. Install NESDK software included in the sensor delivery set. 
For this start NESDK_X.X.exe application for execution, X.X 
denotes software version.

3. Launch the NE SDK Manager program.

 

4. Select the Broadcast Search command in the appeared 
program window in the Search menu. 

The program searches the device in local network. 
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Information on found device is displayed in the main 
program window.

5. Click line with information on the divice. 

6. Select the Configuration command in the Actions menu. 
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7. Put the Change Ethernet Settings mark and customize local 
settings of the device (IP Adress, Netmask, Gateway, IP Con-
fig) according to recommendations of a local network 
administrator in the Configuration window. Then click 
Save&Restart.

8. Close the program. The program must be closed at further 
working. 

9. Be sure that temperature is displayed on device panel on a 
special display. 

10. Launch configurator of weather stations 
WeatherStationPluginConfig (C:\Program Files\
ForwardT Software\Tools\WeatherStations\
WeatherStationPluginConfig.exe).

11. Pass to the DIP Modular System tab.
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click  ● Scan network. The program searches the device 
in local network. When the device is found the IP, Port 
and Slot fields values will be specified automatically. 

put marks that correspond to sensors from which  ●
the FDImageUpdater program must receive the 
information in the Sensors group of elements;
put the  ● Is active mark.

12. Close the WeatherStationPluginConfig application by 
clicking ОК. The program must be closed at further 
working. Weather station is prepared for being used in 
FDImageUpdater.

13. Create task of the SensorEx type in the FDImageUpdater 
program (see the Creation of Tasks section). Select sensors 
which names begin with the DMS prefix.
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3. Stream Labs USB_MS_RS485 Sensor
1. Copy a folder with drivers on PC hard disk. 

 Important: 8 Drivers and application used for customizing of the Stream Labs 
sensor are supplied by the manufacturer.

2. Plug the sensor to PC USB port. The Wizard window appears. 
Follow Wizard instructions. Installation is implemented in a 
standard way.

3. Be sure that the sensor is in the list of system devices. To do 
this complete the following:
а) right-click My Computer context menu and select Properties;
b) pass to the Hardware tab in the Properties window;
c) click Device Manager;
d) look for USB Stream Labs Devices in the list of devices. 
Close the window.
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4. Launch the METEO_Sensor_USB_RS485.exe program to 
check functioning of the sensor. 

 Important: 8 The METEO_Sensor_USB_RS485 program is supplied by the 
manufacturer.

The program searches sensors plugged to PC via USB port.

When sensor is found information received from it will be 
displayed in the program window.

Close the program. 

5. Launch the WeatherStationPluginConfig configurator for 
weather stations (C:\Program Files\ForwardT Software\
Tools\WeatherStations\WeatherStationPluginConfig.exe).

6. Pass to the Stream TPH tab. Put the Is active mark.

7. Close the WeatherStationPluginConfig program by clicking 
ОК. 
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8. Create task of the SensorEx type in the FDImageUpdater 
program (see the Creation of Tasks section). Select sensors 
which names begin with the Stream TPH prefix.
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4. Oregon Scientific Weather Station

4.1. Working With Oregon Scientific Weather Station 
Using Virtual Weather Station Software

1. Plug weather station to PC, turn the station on.

2. Install software from the disk included in the Virtual 
Weather Station software set.

1

The software is installed to the folder specified in the Target 
directory for application field (1).
Program shortcut appears on the desktop after installation. 

3. Launch the Virtual Weather Station program using the 
shortcut. 

 At the first program launch several dialog windows appear. 
In the windows you may select a language and register used 
software. We recommend registering the program.
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4. Specify units of measuring of output data in the Conversions 
window as it is shown below. Then click Close.

5. Select name of plugged weather station in the Weather Station 
drop-down list of the Communication window. 

 
Click Close. Window with the following service message 
appears. 

After clicking OK the program is automatically closed.
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6. Launch the Virtual Weather Station program. Its main 
window and window with title XXX Sensor Communication, 
where XXX is name of station appear.

7. Complete the following in the XXX Sensor Communication 
window:

put marks that correspond to the names of plugged  ●
sensors (if marks are absent);
remove marks that correspond to the names of sensors  ●
that are not used (if marks are put);
put the  ● Automatically close after communication OK mark 
and wait till the window closes automatically (it may 
take several minutes). 

8. Data received from the Virtual Weather Station is displayed 
in the main program window after closing of the XXX Sensor 
Communication window and if the station functions correctly.

 The program initializes output of data in the dbase.csv file 
during some time (it takes 1 minute approximately). 
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9. Launch the WeatherStationPluginConfig configurator for 
weather stations (C:\Program Files\ForwardT Software\
Tools\WeatherStations\WeatherStationPluginConfig.exe).

10. Pass to the Oregon Scientific tab in the WeaterStationPluginConfig 
window.

 

Complete the following on the tab:
select a model of plugged weather station in the  ● Model 
drop-down list;
specify a full path to the file that launches the  ●
program that outputs data received from weather 
station on PC in the Application path field (for example, 
vws.exe). For this use the Browse... button to open a 
standard dialog window and select the file;
specify time interval between reading of data from  ●
weather station in the Refresh every field; 
specify a full path to the  ● dbase.csv file in the Data file 
field by completing the following:

1. Pass to the Virtual Weather Station program 
window.

2. Select the Open Data File command in the File menu.  
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3. A full path to the folder with the dbase.csv file is 
displayed in the Open Data File window in the Direc-
tory History field. Memorize this path. 

 

4. Close the window by clicking Cancel. 
5. Pass to the WeatherStationPluginConfig program 

window. 
6. Click Browse... to specify path to data file. Specify 

path to the dbase.csv file mentioned on step 3.
put the  ● Is active mark.

12. Close the WeatherStationPluginConfig application by 
clicking ОК. 

13. Close the Virtual Weather Station program using the  
File > Exit menu command.

14. Launch the FDImageUpdater program.

15. Create task of the SensorEx type in the FDImageUpdater 
program (see the Creation of Tasks section). Select sensors 
which names begin with the WMRXXX prefix, where xxx is an 
index of weather station model. 
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4.2. Working With the Oregon Scientific Weather Station 
using Weather OS 

1. Plug weather station to PC, turn the station on.

2. Install software from the disk included in the Weather OS 
software set. 

1

The software is installed in the folder specified on the Select 
Installation Folder step in the Folder field (1).
Program shortcut appears on the desktop after installation. 

3. Launch the Weather OS program using the shortcut. 

4. Select model of used weather station in the appeared Model 
Selection window in the drop-down list (2) and click OK (3).

3

2
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5. The Oregon Weather Station – XXX window appears, ХХХ is 
index of program version. Click Settings... (4).

4

6. Specify a folder for storing data in the Settings window 
on the General tab, in the Data Directory field (5). The Data 
subfolder is automatically created in this folder that will 
contain data received from weather station at working of the 
FDImageUpdater program. 

 

5

6

Click OK (6).
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7. Close the Weather OS program by right-clicking the  
icon (7) located in task bar notification area. Select Quit in 
the appeared menu.

7

8. Launch the WeatherStationPluginConfig configurator for 
weather stations (C:\Program Files\ForwardT Software\
Tools\WeatherStations\WeatherStationPluginConfig.exe).

9. Pass to the Oregon Scientific WOS tab. 

 

Customize the following items on the tab:
select model of plugged weather station in the  ● Model 
drop-down list;

  

specify a full path to the file that launches the  ●
program that outputs data received from weather 
station on PC in the Application path field (for example, 
vws.exe). For this use the Browse... button to open a 
standard dialog window and select the file;
specify time interval between reading of data from  ●
weather station in the Refresh every field; 
specify path to the folder used for storing of files  ●
selected on step 6 in the Data folder field;
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put the  ● Is active mark.
10. Close the WeatherStationPluginConfig program by clicking 

ОК. 

11. Create task of the SensorEx type in the FDImageUpdater 
program (see the Creation of Tasks section). Select sensors 
which names begin with the WMRXXX prefix, where xxx is an 
index of weather station model.
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5. IRT 5920 Sensor
Transmitting of data from the IRT 5920 sensor to PC is 
implemented via the OPCDataStore server developed by 
sensor manufacturer. The program can be downloaded from 
the «Elemer» website, the site is currently available in Russian 
only:  
http://www.elemer.ru/catalog_1146.html. 

1. Launch the OPCDataStore program. The program does not 
have English interface.

2. Create a new project via the Проект > Новый проект menu 
command.
Line with the name of your PC is displayed in the Дерево 
сети list. 
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3. Put the mark opposite the name of your PC in the Дерево 
сети list. PC net connection settings are displayed on 
information panel.

4. Click Добавить COM-порт on a toolbar. The COM1/9600 line 
is added to the Дерево сети list. 

Complete the following on the panel:
select index of COM port and скорость обмена in the  ●
СОМ-порт and Скорость обмена drop-down lists that 
correspond to specified sensor;
click  ● Проверка связи to be sure that specified port is 
accessible for working.
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5. Click Добавить прибор on the panel. The Прибор line appears 
in the Дерево сети list.

Customize the following on the panel:
specify 9 in the  ● Тип прибора field;
specify 0 in the  ● Сетевой адрес field;
click  ● Проверка связи to be sure that settings are made 
correctly;

 Note: Required values of the Тип прибора parameters are specified in 
instruction supplied to the IRT 5920 sensor. 

click  ● Считать конфиг. Name of the sensor is displayed 
in Дерево сети list instead of Прибор. 
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6. Click Добавить канал on a toolbar. 
Line with name of channel appears in the Дерево сети field. 

7. Click Проверка связи on information panel. Measured value 
appears in the filed located near the Проверка связи button if 
data is correctly received from the sensor.

8. Save the project by clicking Проект > Сохранить проект как... . 

9. Open the Настройка программы (the Настройки > Настройки 
программы menu command). 
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10. Customize the following items as it is shown below on the 
picture. Then click ОK.

 

11. Launch the OPCConfigurator configurator (C:\Program Files\
ForwardT Software\Tools\OPC\ 
SLGPIOPCConfig.exe).

12. Customize parameters in this program configurator in the 
same way as you customized dealing with OPCDataStore.

 Tip:  g First customize settings in the OPC server channels bar, then 
after creating of a group drag the channel into the Item groups 
bar using the mouse. 
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13. Specify minimal and maximal temperature values in the GPI 
config dialog window. The window is opened by clicking the 
Set GPI params button.

 Tip:  g We insistently recommend specifying nonzero values for the 
Min value and Max value parameters (minimal and maximal 
temperature values), for example , -50 minimal, 50 maximal. 

14. Save made configuration. Close the configurator.

15. Create task of the SensorEx type in the FDImageUpdater 
program (see the Creation of Tasks section). Select sensor 
which name begins with «OPC_».
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6. Tundra Sensor
1. Turn PC off. 

2. Plug the sensor to PC COM port. Turn PC on.

3. Launch the WeatherStationPluginConfig weather station 
configurator (C:\Program Files\ForwardT Software\Tools\
WeatherStations\WeatherStationPluginConfig.exe).

4. Pass to the Tundra tab. 

5. Complete the following on the tab:
specify port to which the sensor is plugged in the  ● COM 
port drop-down list;
put the  ● Is active mark.

6. Close the WeatherStationPluginConfig program by clicking 
ОК. 

7. Create task of the SensorEx type in the FDImageUpdater 
program (see the Creation of Tasks section). Select the 
TUNDRA outdoor temperature (C) sensor.
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7. RMM–4095. Device for Collecting and Processing of Data Received from 
Weather Station

1. Turn PC off. Plug the device to PC СОМ port. 

2. Plug the device to network. Turn the device and PC on.

3. Launch the WeatherStationPluginConfig configurator for 
weather station (C:\Program Files\ForwardT Software\
Tools\WeatherStations\WeatherStationPluginConfig.exe).

4. Pass to the RMM–4095 tab.

 

Customize the following:
specify port to which the RMM-4095 device is plugged  ●
in the COM port drop-down list;
specify corresponding correction values for  ●
temperature, pressure and humidity indicators in 
corresponding text fields of the Correction group. The 
FDImageUpdater program will receive data adjusted 
according to the specified values;
put the  ● Is active mark.

5. Close the WeatherStationPluginConfig program by 
clicking ОК. The program must be closed at further 
working. The RММ–4095 device is prepared to be used by 
FDImageUpdater program.

6. Create task of the SensorEx type in the FDImageUpdater 
program (see the Creation of Tasks section). Select sensors 
which names begin with RММ-4095.
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8. RMM–4095E. Device for Collecting and Processing of Data Received from 
Weather Station

1. Plug the РММ-4095Е device to PC network port and local 
network. Turn the device on. 

2. Be sure that the device is detected. To do this launch 
Microsoft Internet Explorer on one of PCs in local network. 
Specify IP address of the device in address line (see Tip 
below) and pass to the web page: 

if the page with message on error appears then the  ●
device is not detected. In this case appeal to network 
administrator.

if the page presented on the picture below is opened  ●
in the Internet Explorer window then the device is 
detected.

5
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 Tip: g The RMM-4095Е block is supplied with a preset IP adress – 
192.168.0.205. 
There is a possibility of changing IP adress by completing the 
following:
1. Connect the device and PC using a net cable. Turn the device on.

2. Launch Microsoft Internet Explorer (when using other 
browsers information can be displayed incorrectly). Specify: 
http://192.168.0.205 in address line and press Enter.

3. If the following window appears in the Internet Explorer window 
then click OK without entering anything.

 
4. Select Network (1) in the appeared window.

1
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5. Page for customizing of network connection appears.

3

2

4

5

Customize settings recommended by your administrator in the  
IP Configuration group (2), then click OK (3) and click Apply Settings (4). 

5. Right-click Connection (5).

6. Search for the value displayed in the Endpoint Configuration 
group in the Local Port field (6). Memorize this value. The 
value is necessary at customizing of the device in 
WeatherStationPluginConfig program configurator. 
 

6

7. Close Internet Explorer.
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8. Launch the WeatherStationPluginConfig program 
configurator for weather stations (C:\Program Files\
ForwardT Software\Tools\WeatherStations\
WeatherStationPluginConfig.exe).

9. Pass to the RMM–4095E tab in the appeared configurator 
window.

 

Customize the following items on the tab:
specify IP address of the device in the  ● IP address field;
specify port used for interaction of the device and PC  ●
in the Port field (10001 is by default, see step 6);
specify corresponding correction values for  ●
temperature, pressure and humidity indicators in 
corresponding text fields of the Correction group. The 
FDImageUpdater program will receive data adjusted 
according to the specified values;
put the  ● Is active mark.

10. Close the WeatherStationPluginConfig program by 
clicking ОК. The program must be closed at further 
working. The RММ–4095 device is prepared to be used by 
FDImageUpdater program.

11. Create task of the SensorEx type in the FDImageUpdater 
program (see the Creation of Tasks section). Select sensors 
which names begin with RММ-4095E.
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9. Temperature Sensors that Work with the Temp. Keeper Program
The Temp. Keeper (http://isens.ru/about.html) program is used 
to work with temperature sensors based on DS1820, DS18S20 
michrochips developped by Dallas Semiconductor. The link is 
currently available in Russian only.

Workflow of preparation:

1. Plug the sensor to PC. 

2. Launch the Temp. Keeper program. 

3. Be sure that temperature measurings received from the 
sensor are displayed in the program window.

4. Click Настройка (2). 
 

 

5. Customize the settings in the Настройка appeared window. 
Customize the following settings on the Log tab:

put the  ● Записывать лог mark;
put the  ● Имя файла mark in the Настройки лог-файла 
group;
specify the keeper.log name in the  ● Имя файла field.

 Important: 8 You must obligatory specify the keeper.log name for a correct 
interaction of the FDImageUpdater and Temp. Keeper programs via 
log file. 

http://isens.ru/about.html
http://isens.ru/about.html
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Click OK to exit the window with saving of all customized 
settings.

6. Close the program.

7. Launch the WeatherStationPluginConfig weather station 
configurator (C:\Program Files\ForwardT Software\Tools\
WeatherStations\WeatherStationPluginConfig.exe).

8. Pass to the Temp. Keeper tab.

Customize the following settings on the tab:
specify time interval between data updating in the  ●
Refresh every field;
specify a full path to the  ● keeper.log file in the Data file 
field;
put the  ● Is active mark.

9. Close the WeatherStationPluginConfig program by clicking 
ОК. The program must be closed at further working. 

10. Launch the Temp. Keeper program.

11. Create task of the SensorEx type in the FDImageUpdater 
program (see the Creation of Tasks section). Select sensor 
which name begins with the Temp.Keeper prefix.
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 Important: 8 The Temp. Keeper program must be obligatory launched when images 
are customized and output.  

http://isens.ru/about.html
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Recording of Data on Weather Into a Text Fie

1. General Information
Function of recording of data on weather must be activated if 
it is necessary to use information coming in FDImageUpdater 
program from weather stations via other programs.

 Important: 8 You must create a task for working with used weather station to 
output data on weather into a text file in the FDImageUpdater 
project.

2. Recording of Data on Temperature
Working with any sensor supported by the FDImageUpdater 
program you can organize output of data on temperature into a 
text file.

Only temperature value is recorded into a text file. Output of 
data is implemented periodically.

Complete the following to organize output of data: 

1. Open the Project Settings... window using the  
Settings > Project Settings... menu command.

2. Put the Write weather data to text file (1) mark in the Project  
Settings... window.

1
2

3

4
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3. Click Browse... (2) to specify text file for data output in the 
appeared window.

4. Specify the Temperature only value in the Select sensor type 
drop-down list (3).

5. Save project settings by clicking OK (4). 

3. Recording of Data on Temperature, Pressure, Humidity
Output of data on temperature, humidity and pressure into 
a text file can be implemented only when dealing with the 
following sensors:

Stream Labs USB_MS_RS485; ●
RMM–4095 (device for collecting and processing of  ●
weather data).

Data is recorded into separate lines that have the following 
format:

t=XX is a line with data on temperature, where XX is 
temperature value;

p=YY is a line with data on pressure, where YY is pressure 
value;

h=ZZ is a line with data on humidity, where ZZ is humidity 
value.

Picture below presents an example of file with data on 
temperature, pressure and humidity opened in Notepad editor.

Complete the following to organize output of data:

1. Open the Project Settings... window using the Settings > Project 
Settings... menu command.

2. Put the Write weather data to text file (1) mark in the Project  
Settings... window. 

1

3
2

4
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3. Click Browse... (2) to specify file used for output of data in the 
appeared window.

4. Select one of the following values in the Select sensor type 
drop-down list (3):

Stream TPH if the Stream Labs USB_MS_RS485  ●
sensor is used;
RMM–4095 if either RMM-4095 sensor or RMM- ●
4095E sensor is used.

5. Save project settings by clicking OK (4).
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